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Introducing Cue Player One  Top Next

Baxel Data already has two professional grade software packages for theater - Cue Player Premium
and Cue Player Lighting. One or the other is in use in over 1000 theaters, churches, and schools
worlwide. However, not all theater is professional. There are many more local, or community, theater
groups that needed something they could have on a laptop or portable computer they could bring into
the venue just for the performances. 

Cue Player One was born of this need. It combines the sound and lighting features of our mainline
software into one program, one cue list. Some features have been removed for simplicity (but, not
many!). Others have been brought forward, such a specific screen for OSC signals and web based
messaging.

The hope is Cue Player One will give performing artists of any production size the ability to enjoy
consistant computer control of all their technical support functions.

Copyright © 2020 by Baxel Data Systems. All Rights Reserved.
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Getting Started Previous Top Next

The installer will create a Cue Player One folder and copy in the files:

            /lcsv - fixture profiles for all the instruments Baxel Data has encountered

/LibAV64 - the support files for video projections

/Shows - a directory for user created cue files

CPOne.exe - the main executable to run

            Playwin.exe - the video projection executable

           FollowSpot.exe - the program to support browser based messaging

            Prompt.exe - the executable for local (same computer) prompt messages

RestartCPO.exe - a worker program to restart CPO after changes

unins000.exe - the uninstaller executable

There are also several support files for the lighting feature to work with fixtures, groups, scenes,
softpatching, and submasters.

https://www.helpndoc.com/feature-tour
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Contacting Us Previous Top Next

Main Home page - www.baxeldata.com

E-mail - support@baxeldata.com
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About Baxel Data Previous Top Next

Baxel Data Systems is known primarily for the Cue Player Premium software package. That software
controls the sound effects and video projections in over 1000 theaters, churches, and schools around
the world.

Our focus is to bring comprehensive, affordable tools to the entire theater community, not just the 500
seat houses. I am technical director at a theater, the software is used and developed there, not in an
office by people who have never done a live show. Any new version has gone through the run of a show
at our theater before being released.

Baxel Data also has non-theater software, notably Slide Share. That package will allow slide
presentations to be shared from a host to any browser capable device. If you go to the Baxel Data web
site you will also see a variety of free tools I've developed along the way.

Copyright © 2020 by Baxel Data Systems. All Rights Reserved.
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The Main Screen

The Main Screen
  

The Main screen is divided into two sections. The top has the elements of a cue list, with colored cue
types, timings, and action icons, sliders for volume control, and buttons for commands to a cue. The
bottom is a grid of lighting channels, separated by tabs to size, showing the current levels of each

https://www.helpndoc.com/create-epub-ebooks
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channel. A separator bar between the sections allows for sizing top and bottom within the operating
window. Any time the bar is moved or the window resized, the lighting grid will redraw to minimize the
number of tabs.

The lighting channels can be either underneath the cue list, as above, or next to it when using a wide
screen display.

The switch is on the top menu under Lighting Options. It may take resizing the screen and moving the
splitter bar to get the display where you like it if switching back and forth.
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Tool Bar Previous Top Next

The Tool bar has icons for most of the tasks of setting up a cue list and running a show. Patching,
Fixtures, Messaging, and Preferences are on the bar, but discussed under their own Help topics.

  The first group is the Files section. The icons trigger the activity for creating a New cue
file, Loading an existing cue file, or Saving As (for backup) the current cue file. Individual Cues in the
current file are saved via the Record icon or enter key, as the show is developed, so there is no Save
icon.

  The edit group has the triggers for Cut, Copy, Paste, and Save as.... Selecting a cue
in the list will gather all the parameters for that cue. Cut will remove the cue from the list, but keep the
parameters in memory. Selecting another cue in the list and clicking Paste will insert the the saved cue
above the selection. Copy follows the same action, but keeps the current cue in place as well. Save as...
will allow you to enter a cue number and save the cue at that point. It is possible to overwrite existing
cues that way, so a reminder prompt will appear in that case.

  This is Add, Insert After, Insert Before, and Delete. Before and After would be
relative to the currently selected cue. Delete will simply remove the cue from the list. The add screen will
appear for both Add and Inserts:

 A tabbed window will open showing the 4 different
types of cue. The Add screen is customized for each type and explained under the topic Cue Types.

 The runtime group has buttons to turn Blind mode on or off,  Autoadvance on or off,
to Record the current cue levels (the Enter key will also record), and to Play a cue. The space bar will
also Play the cue. To Play a cue immediately, without fades, right click the Play button. Pressing the
space bar and the Ctrl key together will also play the cue immediately. Turning Blind and/or

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Autoadvance off is useful during cue setup and can be toggled with the F4 and F5 keys so you don't
have to use the mouse.

  The first X will break out of a loop or stop a running cue. The Pause/Break key will also. The
second X is the Blackout button. All dimmers will be set to their minimum value, which may or may not
be zero. The ESC key will also do a blackout.

  These buttons are for the additional lighting functions of setting up Global cue
changes, Softpatches, Submasters, Groups, Magic Sheet, and Fixtures (LED lamps). Other than
Global, these functions are explained under their own Help topic.

 Global or Channel changes allows you to
change channel levels across the entire cue file or selected cues. This lets you, for example, add in a
level for the piano light you forgot about, or move a light to another channel when a dimmer conks out.

 The final group is for setting up network based prompts and overall preferences.
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 Network or Web prompts are one of the Control
cue options. They are intended for followspot and backstage prompts. As a cue, the message is in the
cue description and sent when the cue is played. This screen allows for an immediate message. The 'L'
type is not network based, but will work with a video window from the main Cue Player One computer
as an additional screen. This would be used for a followspot monitor in the booth. The other locations,
A. B. C, and D are remote connections from web browsers on the remote users phone or tablet. The
Setup button is used to enter the location descriptions. Users are asked to login when they connect and
their name appears in the leftmost button. They can then be matched to their position A,B,C, or D via
the dropdown. This is a required pre-show setup task. A quick message can be sent from the message
box by clicking the button. Use within the cue file is explained in the Control topic.



CP One  Help

12 / 73

 This window controls the operational settings for the
program. First, which key should be used to trigger a cue; the Space bar or the Enter key.  Adding Page
Down gives the option for common hand-held "clicker" tools. Second, you may select the style, or
appearance of the program. The Help file pictures were taken with Charcoal Dark Slate selected. Setting the
Clock color will affect the running clock in the upper right corner of the main screen. After a cue list is
written, it can be renumbered by the increment indicated. A Warm Up Level other then 0 can be specified
and would be the minimum level for incandescent lamps.

The number of light channels used or displayed can be set up to a limit of 512. This is the normal maximum
of a lot of USB and Art-Net interfaces. It is recommended to set it to the actual number of channels you have
at your venue.

The font and font size of the cue list can be set to what pleases you. The background color of the cue list
can be lighter or darker.

Keep Alive simply activates the disk drive every minute so that it stays spinning. Still, it is recommended
that power control be turned off. That is, set the computer to be constantly on. It would also be a good idea
to turn off any virus checking program.You do not want a virus scan starting half way through Act 1. This is
not necessary when using a SSD on the computer.
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The change amount for levels at each movement of the mouse wheel can be set to 1, 2, 5, or 10. Your color
scroller levels can go from 0-100 or 0-255. If 100 is maximum, then they are internally multiplied by 2.55.
Setting a Fade default will prefill the fade time value of added light cues.

Set Display Refresh determines how frequently, or if, the level settings of the channels scroll to their new
levels as a cue is being played.

If Auto Open is checked, then the last used cue file will be loaded when the program starts. Auto Increment
will prefill the Cue Call field with the next highest number. When video players are set to open on additional
monitors or projectors, Reset Video position will move them back to the main monitor as a convenience. Up
to 5 video players can be controlled in cues. Some may be local video ports on the main computer, some
may be running on remote networked computers. Setting the number of local instances will open that many
players at program start.

Finally, the port number used to listen for OSC commands from other devices can be set. See the
Connections help topic for details.
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Cue List Previous Top Next

          

 The Cue list has 6 columns. The first is the Cue Number and is the list sorting key. All the cue numbers
are sequential, but don't have to be equally spaced. The second is the Cue Call or the number of the cue
that the stage manager will call to be played. The third is the description of the cue as it relates to the
show, where the light is, what the sound is, what action is taking place, etc. The forth is the running time
for the cue, in seconds or tenths of seconds. If the cue is a split fade, both times will show. The fifth
column is the remaining run time of the cue. When not being played, it is the duration. The final column
displays a green play icon if the cue is an autoplay cue. The description will also be indented by one for
an autoplay cue. An Advance at Start cue is indicated by the blue down arrow. A Loop cue will show
the curved arrow. X's are for crossfade cues. The cue you are sitting in (has been played) is marked in
orange. A playing/in process cue will be colored green.

https://www.helpndoc.com
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Run Time Previous Top Next

 This group of buttons controls the active running of a cue. The Play
button will start a selected cue running, the same as the Space Bar or Enter key does. The others do as
their titles would indicate. Those actions are also available to be performed as a cue themselves. That is
the preferred way, such that the operator only has to worry about pressing the Space bar at the proper
moment and not what function is needed. During a performance, these keys would not normally be
needed.

  These are the volume control sliders and the cue position button. The first two
sliders are for the left and right stereo volumes of a played sound. If they are linked, moving one slider
will move both. Unlinked, they are independent. While a cue is playing, if the right mouse button is down
and the sliders moved, the volume will change. When the button is then released, a prompt will come up

https://www.helpndoc.com
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asking if the cue itself should be changed to this new volume. The slider with the green dot controls the
computer's master volume level, which would be effective for all cues. This applies to sound cues sent
out the computer's default sound output. A cue using a plug-in card or USB sound interface in addition
is not affected.
The button will open a horizontal slider where the currently playing position in the sound or video file can
be set. Useful during rehearsals. Move the mouse away from the slider to close the window.
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Channels Previous Top Next

  Each channel has its own level box. The
channel number is shown, along with a red alert icon indicating that it is selected for level setting or not,
and finally, a field for the level itself. Cue Player Lighting will support up to 1024 channels. The number
of channels displayed depends on the screen size and will automatically display as many as it can based
on the window size. The additional (leftover) channels will appear on subsequent tabs across the top.
The total number of channels is set in Preferences under "# of Channels".

Channels are selected in the same manner as items in a list in other Windows programs: single click in
the box will select just that dimmer, Ctrl-Click will select individual dimmers, keeping previous ones,
and Shift-Click will select the range of dimmers from the first to the one Shift-clicked. A right-click on a
selected channel will unselect it. Holding the mouse down and dragging will select the channels the
mouse rolls over. The Delete key or clicking any clear area on the main screen will clear all selected
channels.

The level can be set by typing a number in the level field, or from the keyboard. Up and Down arrows
for a change of one, Page Up/Page Down for a change of 10, and Home/End for a change of 100. The
mouse wheel can also be used to scroll values up and down.

 A channel can be locked by double-clicking the box. Once locked, it will not change
from its current value as cues are run. The intended use is for an emergency or burn-out recovery during
a performance.

Levels for intensity go from 0 to 100. Levels for colors of LED fixtures and scrollers can go from 0 to

https://www.helpndoc.com/create-epub-ebooks
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255. That is also a Preferences setting.

Commonly used groups of channels can be defined. See the Groups topic for more information.

 Active Submaster channels will have a tourquoise colored dot. If the submaster is taken
down to 0, the dot will disappear.



CP One  Help

19 / 73

Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

Clock/Timer

Clock/Timer
  

Normally, the upper right corner of the Main screen shows the current time. The text color is set from
the Preferences screen. During rehearsals, however, there is often a need to record the run time of the
act or show. Right clicking the clock will bring up this menu:

 Selecting 'Start Timer' will change the clock display to this:

 Which is simply a running timer. It can be paused or resumed from the menu,
or the clock can be returned to display.

https://www.helpndoc.com/create-epub-ebooks
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Selecting the Sound tab after + on the home screen will display the above screen. The Save, Save/Add, and
Exit buttons are common to all of the 4 tabs. Save will either add a new cue to the list or store any changes
to an existing cue. Save/Add does the same, but returns to this screen instead of the main window. Exit
returns to the main window.

Cue entry starts with the sequential number of the cue, followed by the Call that the stage manager would
use, and then the cue's description. These will be the contents of the first three columns of the cue list. If
Autoincrement is a selected option, the number fields will be prefilled. Sound files may be typed in, drag and
dropped from a file manager, or selected via the folder button.
You may select a color for the text of each cue.
If the sound file entry is just a number, then the cue is considered a volume or action cue for that number
cue. 

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour
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The trigger for playing or running the cue can be either when the cue is selected,  the Play key, as set from
the Options menu, the time position of an already running cue, or a time of day. The number of a playing
cue goes into the Cue # field and the time position, in tenths of a second, goes into Time field. If the Cue #
is 0 and the Time is entered as hh:mm, the cue will play at that time. Hours greater than 12 are afternoon
and evening, under 12 for morning. For the cue you are editing to be triggered this way in use, it must be the
current selected cue in the cue list.

The Test button will play the cue as if it had been saved and triggered from the main screen. Stop will stop it
and Same will transfer settings for EQ, Reverb, and volumes from the previous sound cue to this one during
editing.

The initial volume level can be set, as well as defining a cross-fade to another volume level to happen
automatically when the cue starts to play. You can fade-in or out as you wish. The duration of the transition
is the value in the Fade Time box in tenths of seconds (xx.y). Between the sliders is a vu meter showing the
volume levels when using the Test button to play the sound file. If the cue is an action cue, indicated by a
cue number in the sound file field, the leftmost sliders will be fixed at the ending volume of that cue.

Cue Action is selectable for numbered sound file entries. If the sound file name is an actual sound file, then
Play is the only option and the drop-down is disabled. Otherwise, you may select Pause, Resume, Fade
Out, Stop, Wait for End, End Vamp, or Fade to Pause to affect the numbered cue. End Vamp lets a
vamping cue continue to the end of its file. Fade to Pause fades out the sound as in Fade Out, but rather
than ending the play, pauses the file so that it can be started again at the same place with a Resume cue.
Play Loaded will simultaneaously play all preloaded cues, sound or video. This allows two or more sound
cues that have different sound devices to be played with their outputs synchronised.
Cue Advance will drop down to allow selection of No, at the End, at the Start, when a Fade is started, or
when a file is loaded or rendered. All of these Advances are available so that the cue list can be designed to
run simply going cue to cue.
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To avoid having to edit a sound file to shorten it, or to set the exact start and stop times of a loop, that
timing can be set here. The time can be typed in or when the button clicked, this screen appears:

The left mouse button or the aqua arrows will move the start time, The right mouse button or the yellow
arrows will move the end time. The Test button will play the file. If Loop is checked it will continue to play
while the times are adjusted. While playing, the Mark button will copy the current playing location to the
clipboard. You may then paste that time easily into a Time Line cue 'Time:' position. If 'Vamp' is checked,
the cue will play from 0 to the end time and then loop back to the start time. It will continue that loop until a
cue with the Action 'End Vamp' is played, at which time the loop end will deactivate and the file will play to
the end.

 The Speakers box allows selection of which speakers will play the output as well as
the sound card used to do it. The program will inspect and discover all available outputs and put them in the
dropdown box. The caption will indicate how many speakers the selected sound device has available. Stereo
input files can be sent to any pair of speakers. Front and Rear can be selected together for a quadraphonic
output. If the sound source file has more than one track (e.g. 5.1 has 3), the Matrix selection will show this
selection screen:

 Here input channels can be sent to outputs as a matrix. As
illustrated here, the input channels are matched to their expected outputs. But clicking X's anywhere in the
grid will send channels to outputs as you wish. 
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 Click the Loop box to continuously repeat a sound until some
action is taken against it. If the sound file is a playlist, the list will be looped. If the cue is an Action cue the
program will jump back to the cue number entered. A loop can be stopped by an Action cue, particularly a
Wait for End, whereby the program will finish the loop and move on. Auto Fade will start to fade the cue at
the Fade at End value before it would normally end. For example: if the cue is 13 seconds and the Fade at
End value is 30, the cue will start to fade at 10 seconds into the cue. All Fade durations are in tenths of a
second. For example, a value of 20 gives a 2 second fade. The XFade checkbox can be used for both sound
and video cues. For video, it indicates the cue will cross fade from whatever is currently playing in the video
to the file for this cue. For sound, since multiple files could be playing, the number in the Cue # field
indicates which cue should be faded out as this one fades in. The fade out time of that cue will be the same
as the Fade time of the cue being edited.

 There is a 5 band
equalizer and a reverb to customize the output sound without having to go back to your sound editor
program to 'tweak' it. There is the option to set the tempo of playback. The speed of the file can be adjusted
plus or minus 25% without changing the pitch. Useful in dance performances to match the choreography. 

 The up and down arrows are used to move the cue being edited up or down in
the cue list. A number can be entered directly and the current cue will move to that line. Be careful
rearranging a cue list with action cues as, for example, a Fade cue for cue #3 will not work if #3 becomes
#2. The program is designed to keep track of movements, but they should be checked. Picking an F key will
set the cue to allow playing that cue whenever that F key is pressed. You may also use the 'k' and 'l' keys
that some key mapper programs employ.
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 Common to all four cue types, these buttons will close the add screen after running. Save
will write the current cue settings to the cue file, whereas Exit will drop them and not change anything.
Save/Exit can be used during cue building to perform a save and then bring back a new add screen
automatically.
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Light Cues
  

Light Cues

You may want to first view the training videos for
Cue Player Lighting as the actions and features
there are the same as here.

Previous Top Next

Selecting the Light tab after + on the home screen will display the above screen. The Save, Save/Add, and
Exit buttons are common to all of the 4 tabs. Save will either add a new cue to the list or store any changes
to an existing cue. Save/Add does the same, but returns to this screen instead of the main window. Exit
returns to the main window.

 These are the
first 3 columns of the cue list. That being the cue sequence number, the stage manager cue call, and the
cue description. As with all cues, the color of the cue description in the list can be set.

 
The trigger for playing or running the cue can be either when the cue is selected,  the Play key, as set from
the Options menu, the time position of an already running cue, or a time of day. The number of a playing

https://www.helpndoc.com/feature-tour/iphone-website-generation
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cue goes into the Cue # field and the time position, in tenths of a second, goes into Time field. If the Cue #
is 0 and the Time is entered as hh:mm, the cue will play at that time. Hours greater than 12 are afternoon
and evening, under 12 for morning. For the cue you are editing to be triggered this way in use, it must be the
current selected cue in the cue list.

 Dimmer settings for any cue can be saved and restored as scenes. The scenes are
stored in a file that can be either show specific or common depending on the "Auxiliary file source" setting in
Preferences. At first use for a cue list, you will be asked if a new file should be created or you want to copy
in an existing file. If new, this screen is next:

 When you save a scene you may name
it what you wish, Save, and it will appear as the next line item. When recalling a scene, click on one of the
listed lines. To delete a scene, blank out the name. The leftmost button will change titles from Save to
Delete. If you select a scene, buttons will appear to allow you to Overwrite the current channel levels with
the ones from the scene, or to Add the scene levels to the current ones. A scene may be assigned to a
bumpbutton. The far left dropdown is used to select the key to enable or blank to disable. Whether bump
scenes are added to the existing levels or are the levels themselves is set in the "BumpOvrRpl=" entry of the
CPOne.ini file. 1 is add, 0 is alone.
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 Cues can be a Single fade, Split fade or Master
fade. A Single fade starts after the Wait time and proceeds over the Fade time to move all the selected
dimmers to their new values, brighter or dimmer. A Split fade will treat the dimmers going brighter and those
going dimmer differently according to the values set in the Wait and Fade values. A Master fade will fade out
all channels, including any settings of an active submaster. All transitions are stored by channel so multiple
scene fades can be active at the same time.

 If the next cue in the list an Autoplay cue, then checking here and entering some
seconds will have the same effect as having this cue advance at start and inserting a Delay cue. Just saves
a cue.

 You may loop a series of cues by entering the cue to loop to from the current
cue and the number of times the loop happens. The red X on the tool bar will stop the loop at any time.

  The up and down arrows are used to move the cue being edited up or down in the cue list. A
number can be entered directly and the current cue will move to that line. 
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Video

Video Cues
  

Video Cues Previous Top Next

Selecting the Video tab after + on the home screen will display the above screen. The Save, Save/Add, and
Exit buttons are common to all of the 4 tabs. Save will either add a new cue to the list or store any changes
to an existing cue. Save/Add does the same, but returns to this screen instead of the main window. Exit
returns to the main window.

 These are
the first 3 columns of the cue list. That being the cue sequence number, the stage manager cue call, and
the cue description. As with all cues, the color of the cue description in the list can be set. Up to five video
players can be connected. The Screen selection sends this cue to the desired player. Whether that player
is local or remote depends on that number and the number of local videos you entered in Preferences.

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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 This is the
file name and location of the picture or video to be played. The button will bring up a file browser. Video files
can be a format of  .mpg, .avi, .divx, .wmv, .mov, .mp4, .mpv, .mkv, .m4v, .mpeg, .vob, .jpg, .jpeg, .jfif, .bmp,
.tif .gif, .png.

 
The trigger for playing or running the cue can be either when the cue is selected,  the Play key, as set from
the Options menu, the time position of an already running cue, or a time of day. The number of a playing
cue goes into the Cue # field and the time position, in tenths of a second, goes into Time field. If the Cue #
is 0 and the Time is entered as hh:mm, the cue will play at that time. Hours greater than 12 are afternoon
and evening, under 12 for morning. For the cue you are editing to be triggered this way in use, it must be the
current selected cue in the cue list.

 Cue Action is one of: Play, Pause, Resume, Fade Out,
Stop, or Fade to Pause.  Play requires a video file name, the others need the cue number of the affected
cue. Cue Advance is one of: NO Auto Advance, Adv at End, Adv at Start, or Adv at Load.

 When played, the video or picture will fade in to the levels set in the
sliders over the time, in seconds, in the Fade field.

 A video may be looped from end to start. Or it may crossfade in from the previous video or
picture. The previous will be faded out over the same time as the fade in. At the end of a video, the image
can go to black or be held at the last frame.

Start/Stop will also appear for Video cues:
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The cyan and yellow markers again define the start and stop positions. The bottom slider will change the
display to the time in the movie indicated under the picture. Please note that start times of a video,
especially a compressed one (e.g. .mp4), can vary from the selected cyan position due to the need to be at
a "key frame". Without going to deeply, computer videos are stored with key frames holding the entire image
and subsequent frames holding the differences from that key frame to the next. To start to play a video, it
must be from a key frame.

A video cue, both picture and movie will have this box at the bottom:

 This let's you set the size and position of the cue on the projector
screen. The Setup button will bring up this window where the corners of the image can be set graphically.
You can still enter the percentages directly if you wish, but what you drag the green dots to here will be
transferred as values to the percentages.
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   The Test button
will transfer the new settings to the projector image so you can see the effect.
   
If Mask is unchecked then the size will be within the green dots. If masked, then the image will fill the
screen, but only the green dot rectangle will show.

  

 Like Tempo for sound, Speed will will adjust the playback speed plus or minus 100%. Expect some
jerkiness in playback once you get down below 10%.

You may want a movie to end with the last frame displayed instead of fading to black. The 'Ends in ...'
buttons control that. A movie cue that ends in image would normally have a Fade cue following it to fade to
black when you want it.

  The up and down arrows are used to move the cue being edited up or down in the cue list. A
number can be entered directly and the current cue will move to that line. 
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Video Player

The best way to use video is to have two video cards in your show computer and set up Windows for a dual
monitor display.On a laptop, there is often an auxiliary port or you could invest in a USB to video adapter. 
You would set that up to have the Cue Player control display on either the left or right and slide the video
player over to the other. The little button with the monitor icon will put you in full screen mode. Even more, if
you right click it while it is still on the same screen as Cue Player (like at startup), it will move the player
over and make it full screen in one click. Which way it goes depends on which half, left or right, the window
is when you click. The 'Resize to Last' option will modify this behavior to moving the screen to the size and
position it last was when closed. You can also double click on the screen part to go full screen or not. A
right click on the screen will bring up a menu about hiding controls and such. When the controls are hidden,
the screen position and size can be fine-tuned using the arrow keys. Ctrl+Arrow will move the screen
up/down/left/right per which arrow. Alt-Arrow will resize the screen - down or right for larger, up or left for
smaller.
Video cues have some additional information in them from sound cues. At the end of each cue is a series of
two or more numbers e.g. C;\video.mpg;0,150, or C:\video.avi;0,132,400. The numbers indicate where the
movie is to start and where it is to pause or stop. In the first example, the movie would start at 0 and stop at
150. In the second, the movie would start at 0, pause at 132 and if resumed, go on to 400 before stopping.
Please note - unlike sound cues which can be buffered such that cue #3 with one sound can be immediately
followed by cue #4 with another and #4 can be selected waiting to be played, back-to-back video cues need
a fade or stop action cue between them. However, pictures and video can be cross-faded one after another.
A series of cross-fades must start with a normal cue. Cross fading is allowed between picture to picture,
picture to video, and video to video.
The sound from video cues does not go through the same audio process as a regular sound cue. As a
result, the equalizer, reverb, and speaker settings of the cue are not in effect. Since almost all theatrical
videos are silent, this is not considered an issue. Should those features be needed, it is suggested to
extract the sound from the video and play it as an additional autostart cue after the video.

https://www.helpndoc.com/help-authoring-tool
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Playwin Settings:
Clicking the tool icon on the far right of the command bar will bring up a window to allow you to set:
Timing - select either using timing information from the playing media itself of an internal timer. The interval
of the internal timer is set in milliseconds. Experience has shown that more repeatable timings come from
the internal timer.
As Is - when displaying images (.bmp, .jpg,, .tif, .png, etc.) the displayed image is rendered at whatever size
it is, independent of the video player window size. Depending on the relative sizes, only part of the image
may appear.
Stretch - the displayed image is stretched to the size of the player corner to corner.
4 by 3 - the aspect ratio of the image is held to 4 by 3, which is the old TV ratio.
16 by 9 - the aspect ratio is held to 16 by 9, or 'widescreen'.
Network - The IP address of the computer running Cue Player must be entered so Playwin can find it. If
running on the same computer as Cue Player itself, it can be left blank or 127.0.0.1 should connect no
matter what the actual address is. Port number default is 50065. If Remote from CP will change the
communications accordingly. If you do not want to click the connect icon every time, select AutoConnect. If
the video player is running on a remote computer not running Cue Player, then Remote from CP should be
checked to enable entering the host computer IP address. You can edit the cueplayer.ini file values for
NetPort to change it if needed.
Audio Output - The audio output device may be selected with the same options as the main cue edit screen.
It applies to all video cues.
Play Delay - there was an issue (since been corrected) with a brief flash of a prior paused video cue upon
display of the next. The fade in of a cue was delayed by the amount of this setting to avoid that. It can still
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be used to 'tweak' sychronization of two computers.
Resize to Last - when the screen icon toolbar button is right clicked, the screen will resize and position to
what and where it was when shut down. A left toolbar click ignores this setting and the screen will expand to
fullscreen.
Send Exceptions - any problems with rendering or display will be sent to the computer running Cue Player.
Background Darkness - a level between 10 and -10 of the background 'black' level. -10 is blackest. You may
want to set this to match the black level of your projector to make image edges blend in.
Vignette Level - the edges of a playing video can be softened to make it blend better with the projection
surface.
Cameras - drop-down selection of any installed cameras for display as cue file name 'Live'.

Right Click menu:

Right clicking in the blue background of the player will bring up a menu of the running controls and
appearance options. Full Screen and Hide Controls are toggles for those two options. Corner pinning is done
by moving the red corner dots to a position on the blue background. Use them to correct the image for
keystoning or an angled projection surface. Clicking 'Markers show Shape' will toggle the screen to show 8
green dots and the prompt to 'Markers show Perspective'. Hiding the markers will save the postions. The
green dots can be moved to create a shape to contain the video. They could be used to mask out a
doorway, for example. When more than one monitor is setup in Windows, the option to quickly move and
make fullscreen to either additional monitor is enabled. If the player has been sized already to a projection
surface and closed, that size and position can be restored with a click.
Here are examples. The blue is the setup screen and the test pattern shows the resulting image.
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Remote Networked Video -
First step would be to copy playwin.exe, playwin.ini, gdot.png, and dot.png from your main Cue Player One
install to a directory on the networked computer. Also copy the LibAV64 directory and its contents to the
same directory. Second, the video files must be the same, and in the same place on both computers. That
is, if sunset.jpg is in the C:/shows/thisshow/pictures directory on your main computer, sunset.jpg wants to
be in the c:/shows/thisshow/pictures directory of the remote computer.
Look at the Help > About screen on Cue Player One and note the IP address of your main computer. Go to
the remote computer and start playwin.exe. Click on the Settings icon (hammer and screwdriver) and look in
the Network panel. Enter the IP address of the main computer and the port number 50065 (default). Check
both boxes AutoConnect and Remote from CP. Position the video window as you would if running at the
main computer. Right click to bring up the options window and select the number screen for this player.
Come back to your main computer and the show cue list. Add a video cue and choose a screen number for
it. The number wants to be something greater than what you entered for "# of local videos" on the
Preferences screen. It will be effective at the next restart. 

-----
Just a general note – playing videos is not easy for computers. While the sound playback will work well with
a entry level laptop, using it to also play a movie may result in stuttering and hangups. For serious video
playback, a desktop computer with a plug-in video card is recommended.
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Control

Control Cues
  

Selecting the Control tab after + on the home screen will display the above screen. The Save, Save/Add,
and Exit buttons are common to all of the 4 tabs. Save will either add a new cue to the list or store any
changes to an existing cue. Save/Add does the same, but returns to this screen instead of the main
window. Exit returns to the main window.

 These are the
first 3 columns of the cue list. That being the cue sequence number, the stage manager cue call, and the
cue description. As with all cues, the color of the cue description in the list can be set.

 There are
five types of control cues. Depending on which is selected here, the corresponding detail frame will be
enabled below. 

 
The trigger for playing or running the cue can be either when the cue is selected,  the Play key, as set from

https://www.helpndoc.com/feature-tour/iphone-website-generation
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the Options menu, the time position of an already running cue, or a time of day. The number of a playing
cue goes into the Cue # field and the time position, in tenths of a second, goes into Time field. If the Cue #
is 0 and the Time is entered as hh:mm, the cue will play at that time. Hours greater than 12 are afternoon
and evening, under 12 for morning. For the cue you are editing to be triggered this way in use, it must be the
current selected cue in the cue list.

 A Delay control cue simply pauses advancement down the cue list
for the entered time. It is always treated as an autoplay cue. Use this, for example, between a video cue of a
picture and a fade cue set to autoplay to display that picture for the delay time.

 Designed for use with a Behringer X32 mixer, this control allows a
cue to mute and unmute specific channels on the mixer. The range of channels controlled goes in the
Range field. The individual channels to be muted in the Muted field. If not muted, channels are unmuted.

 A general purpose send of any valid OSC command
string to the address indicated. It could be fader levels to a mixer, control signals to an external dimmer
desk, whatever. Multiple commands in one cue can be separated by a semi-colon. Receiving OSC
commands is covered under "Connections". X32 Theatre Control and Palladium are two popular 3rd party
programs that integrate with Cue Player over OSC.

 MIDI commands to be sent have the format "xn.xx.xx"
with values per your end device. n is the small device number. Receiving MIDI commands is covered under
"Connections".
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 Although labeled for prompting a follow spot operator,
prompts or messages can be sent to any of four users on the network to their device with a browser. The
Local position brings up a simple video player that can be moved to an additional cabled monitor in the
booth. The A,B,C,D positions are set up from the Prompt icon on the tool bar. Here we see that both
positions B and D will get the message. To receive, the user has to open a browser on their phone or pad
and set the url to the address of the computer running CP One - usually something like 192.168.0.xxx. Note
the server must be started from the top menu File > Enable Web Remote to use this feature.

  The up and down arrows are used to move the cue being edited up or down in the cue list. A
number can be entered directly and the current cue will move to that line. 
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Softpatch

Softpatch
  

Softpatch Previous Top Next

 

            This shows the top and bottom of the softpatch screen. The actual height will depend on the
height of the main screen. Softpatching is a powerful way to customize how you control your lights. If
you are not familiar with it, simply, it is the way to have one or more dimmers controlled by a single
channel on the main screen. If there are several lights aimed at a particular portion of the stage at various
angles, this allows you to set the light level with one channel. The ability to do this is enhanced by the

https://www.helpndoc.com/help-authoring-tool
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feature of proportional dimming. If you look at Channel 2 in the picture, you will see that dimmers 3 and
4 are being set. Channel 4 has the extra notation of /50 meaning that it will, at most, go to 50% of total
brightness. Taking channel 2 from 0 to 100 will therefore have the effect of changing dimmer 3 from 0 to
100 and dimmer 4 from 0 to 50.

Fixture mapping makes it easier to work with LED fixtures. It allows one channel to control the colors
and intensity of a fixture. In this example, there are LEDs with their address settings at 230, 250, and
260. That is, 230 is the dip switch setting, Red may be at 230, Green at 231, Blue at 232, and Intensity
at 233. All that is specified in the fixture's profile. With fixture patching, entering "100R80" into the
channel field of channel 12 will set all of those 230-233 channels to the right value. A right click of the
channel field bill bring up the fixture's color picker so any other color can be selected and mapped to the
correct 230-23x channels. Rather than the complete "100R80", just an intensity value or just a gel
number from either the gel wheel or the user wheel can be entered. This also allows for easy grouping of
multiple fixtures. For example, if there are 4 identical  fixtures covering an area of the stage, they can be
set closely together up in the 400's, but fixture mapped so that channels 10-14 control them, it makes it
easier to write cues. They could even be set as a Group so that "g4" selects all of them.

The Description column has the text that will appear as a hint when the mouse is hovered over a channel
box on the main screen. If the word "nbump5" is in the description, then that channel will bump to 100%
when the F5 key is pressed. "nbump6" works with F6, "nbump7" with F7, and so forth up to 12. If the
word is changed to "fbump5", then rather than a zero count fade when the key is released, a timed fade
will happen. The time is determined by the "BumpFade=" entry in CPLighting.ini. A value of 10 is one
second, 5 is 500 msec., for example. Timed bumps for F5 would be done with "tbump5(x.x)", where
x.x is the duration in seconds. For example, "tbump7(4.3)" would bump the channels where that was in
the description for 4.3 seconds when F7 was pressed, even when released sooner. Entering "abump5"
acts as a toggle switch for that channel and key. Any toggled keys will display on the top line above the
clock.

At the bottom of the screen, the Unpatched Dimmers button will show a window with a list of all the
available or unassigned dimmers. Save will record any changes and Exit will close the screen without
saving.
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Submasters

Submasters
  

Submasters Previous Top Next

  There are 8 submasters available in Cue Player One. When the
Record button is clicked, any channels with an active red dot will be recorded into the submaster at
their current level. An easy way to select channels is to use the "g/" keystrokes to select all active
channels. The sequence would be to have the scene levels you want to have on the sub be visible, its
channels selected with red dots, have the sub slider at the top, and then click Record. The submasters
are additive with a Higher Takes Precedence based on the previously run cue.

 The Add/Edit screen looks like this:

 It is opened by clicking in any of the 8 top description boxes. The
Description is shown as the top line for that submaster, the Hint when the mouse is over that top line. A
submaster can also run a loop file independently of the main channel settings. This allows you to bring up
an effect without changing the rest of the stage.

https://www.helpndoc.com/help-authoring-tool
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Submasters can be assigned to a channel via Softpatch. Submasters are numbered after the total
channel count. That is, if there are 128 channels in the main display, the subs are numbered 129 to 136
and can be softpatched to any of the other 128 channels. An example use would be to have a chase
effect as a cue/loop file assigned to Sub 1 (129), pached to 120. If 120 is in a cue the chase is dimmed
and brightened according to 120's value in the cue(s).

You may have a submaster channel selection for the current cue file or an independant one as a Rep
Plot.

Check the box to use a Rep Plot and uncheck to align with the current cue file. A good use of the Rep
Plot setting is in conjunction with a slider surface. A midi device like the Pyle  PMIDIPD30 can be used
to control the 8 submaster channels.
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Here sliders 1-8 match up to subs 1-8. You could have each sub control a stage area or LED color and
run a presentation or book reading where you didn't want to create a cue file. The Pyle bump buttons
under each slider are active as well.
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Fixtures

Fixtures
  

Fixtures Previous Top Next

  The Fixtures screen is designed to work with the
newer LED lighting instruments and any color scrollers you may have. The first step is to select a
particular fixture from the top dropdown. One of the options there is to Add a new fixture.
Unfortunately, there are only about 10 profile files included in this install. If you add fixtures, it would be
great if you could forward their settings back to Baxel Data and we will include them in future software
releases.

Having selected a fixture, the starting DMX address of an installed fixture of that type and a Note to be
used as a hint on the main screen would be entered and Save clicked.

Adding or editing a fixture will bring up this screen:

https://www.helpndoc.com/feature-tour/iphone-website-generation
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The Name and Description are the text you want to recognize the unit by. Known fixtures that have a
profile already can be loaded via the Load from File button. The DMX channels for the colors, intensity
levels, and movements need to be entered, as well as the total number of channels to set aside for this
fixture. The minimum setting for Intensity can also be entered. You can select whether the display goes
from 0 to 100 or 0 to 255 and enter a channel description that will show up as a hint for that channel on
the main display. When you Save, a file will be written you can use to Add.

A completed screen could look like this:



CP One  Help

46 / 73

Going back to the Fixtures screen, having selected a fixture, the address or addresses of where these
fixtures are installed is entered in the Add and Remove box.
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3 Color 5 Color 

Next, using one or more of those addresses, a color picker can be displayed to choose the combination
of RGB needed to produce the color you want. Also, entering either a Roscoe (Rxx) or Lee (Lxx) gel
number will show its color and corresponding RGB values. If the Show Now checkbox is checked, the
colors will be sent to the fixture as you move the mouse. If the Include Patches is clicked, then any
softpatched fixtures to that address will also show the color. When the Save button is clicked, these
values will be written to all the correct locations for the fixtures you selected.

To make it easier to select often used colors, the concept of a "user palette" is available. The LED
values need to produce various colors will vary from manufacturer to manufacturer and/or fixture type to
fixture type. The values used to make the colors consistent at a venue can be saved and recalled.

 The Save to User button will add the current values of LED levels to a slice of the User palette. Here is
an example:



CP One  Help

48 / 73

 

To use palettes, enter a value in the level field of the palette (abitrarily picked as the Red) channel. For
example, a fixture is set to address 150 and it's Red channel is 1. Normally, Red would therefor be set

by values in channel 150. In the channel display it will appear like this:  Entering a
user palette number in channel 150 (e.g. "U3") while the Shift key is pressed will set all the LED addresses
of the fixture to the stored values for that palette color. A limited number of Rosco gel colors can be used as
well.
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To manage the user palette, the Options tab has
selections to Add a new color, as seen in the square above "Show Now" and represented by the current
values in the Red, Green, Blue, Amber, White fields. The colors of an existing gel can be reset for the
palette, the current fixture, or for all fixtures. For example, if you need to adjust the colors for R80 or U2 for
fixture "ABCD" and/or fixture "WXYZ", you can save them here and they will be recalled when that fixture is
selcted.

A right click in any channel box of a fixture will open the fixture window with the installed address
selected.

Entering in the addresses of the scroller channels will allow them to be set from 0-100 or 0-255 as per
your Preferences and not be affected by a Blackout command.

The 'In Use' button will bring up this screen for example:
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 A list of the currently assigned channels and their
fixture names serves as an aid to adding new instruments.
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Groups

Groups
  

Groups Previous Top Next

 

Groups of channels can be defined to quickly select those channels instead of individually clicking them.
For example, if your blue back lights are in channels 11-16, typing "g5" on the keyboard will
automatically select and show the red dot of all of those channels. Typing "g/" will select all non-zero
active channels in a cue. The entries can come from a file specific to the show's cue file or from a
generic file linked to the program. That is a choice on the Preferences screen. If it is clear and you want
to start with the generic file, click Copy.

https://www.helpndoc.com
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Magic Sheet

Magic Sheet

  

Magic Sheet Previous Top Next

A Magic Sheet is a tool that allows a graphical display of instrument locations and channel selection of
those instuments. Groups of lights may be defined or broken out for quicker selection. Clicking on a
channel button here will select and move the mouse to that channel on the channel grid. The intensity and
color are then set as normal. The sheet can be resized and moved as needed. 

Adding a group area is done with a right click anywhere on the sheet.

 This menu will appear. Since the group areas
cannot be resized with the mouse, a choice of starting sizes is offered. Once created, the group can be
resized by right clicking within it. The Grid size determines the gap between channels for the snap-to

https://www.helpndoc.com/help-authoring-tool
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feature.

 The menu is also used to name the group and add channels to it.
Once a channel is created, it is named by its own menu.

 Channel buttons may be dragged and postioned anywhere within
their group box. There is a small snap-to feature to make it easier to align rows and columns of
channels.

The intent is to aid cue writting by showing the channels used for various physical locations of
instuments.

Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

Connections

Connections
  

Connection to Cue Player One can be made via either MIDI or OSC. 

MIDI commands can come from light board consoles or microphone control programs like Palladium. Cue
Player works in what is called "non-linear" mode, where cues are selected as they are played.

The MIDI commands are as follows, where n is the MIDI small device number and TT is the track or cue line
number from Cue Player:
Emergency Stop - Bn.7B.00
Play - 9n.TT.00
Pause - 8n.TT.00
GoTo - Cn.TT
Stop - 8n.TT.01

Here is a screen shot of the Palladium setup:

https://www.helpndoc.com/create-epub-ebooks
http://www.chsounddesign.com
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Use the "Set MIDI Input Port" Options menu selection to set the port. You will need to edit the
cueplayerone.ini file if you need to change the channel number (device 1) from 0.

OSC (Open Sound Control) commands come in on the listening port number defined at the bottom of the
Preferences window. Valid commands are: Play, PlayXX,  and GotoXX where XX is the cue number. Fades
and pauses are better handled by control cues within the cue list and given their own play command.
Function keys can also be simulated when "fx" is received

Cue Player One can be integrated with the popular program 'X32 Theatre Control' to allow it to trigger Cue
Player cues. Please look at the X32 TC manual under 'Playback Cue Control' and 'Show Setup >
Playback...' for details on how to implement.
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File Menu
  

File Menu Previous Top Next

The File menu deals mostly with the creating and loading of cue files. A New Show creates a blank cue
file and Load brings up a file browser to locate an existing file. Up to the last 8 show's cue files will be
listed as Most Recent Shows. A sub-menu will appear with the shows listed. 

Backup/Save As ... is used to create your own backup of the currently open cue file. Changes to the
current file are saved as they are made so there is no plain Save option. Each time the program is
shutdown, a copy of the cue file is made and named shownameYYMMDDhhmmss.ocue. The
timestamp is Year, Month, Day, hour, minute, second. Up to 3 previous versions are saved.

A cue file can be created from a directory of files. Individual files can be selected. A prompt window

will appear with options for the cue file:  The settings make it easy

https://www.helpndoc.com/feature-tour
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to create a presentation cue list.

One cue file may be added to the end of another to make a longer one. A playlist file (.m3u) can be
created from the files in a directory. This is useful for your pre or post show music playlist. Sometimes
you may have to relocate a cue file for use on another computer. Relocate will move the cue list and
change the file names in the list appropriately. One means of documenting the show cues is exporting the
list and settings to a comma separated values file that can be read by any text editor.

Enabling Web cues will open the networks communications program as a small window in the lower left
of the screen. No interaction with it is needed. When active, a web server is available on port 80 (the
normal browser port). The user need only enter the IP address of Cue Player One, found on the About
window. Once connected, the user will be asked to log in so that she/he can be identified on the  Web
Messages/Network Prompts window.

Enabling Web Remote will open a communications server as a small window in the lower left of the
screen. No interaction with it is needed. When active, a web server on port 8888 can be connected to.
The pages presented will allow cue line selection, playing, pausing, and in the case of light cues, the
second screen allows setting and saving individual channel levels.
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Sound Options Menu
  

Sound Options Menu Previous Top Next

There are many sound default settings, which required this submenu screen:

 Global Fade sets the fade duration for the "Fade All" button. In
computers with more than one sound card, Cue Device allows selection of which device will be the default
for added cues. The output device is still selectable by individual cue. If the Cue Device is changed, the Set
Cues button will update all the cues in the current list. The default speakers for added cues can be set to
that of the first cue in the list. Also there are settings for the default cue type, initial volume, and display
colors. These are also still selectable by individual cue. Checking the Add Control cue will add an additional
control/action cue for each added cue. Auto Color cues will change the cue font color to gold for delay and

https://www.helpndoc.com
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lime for auto-play cues as they are added or edited. The volume level of new cues may be set for less than
100% to allow headroom for later increases.

The Volume curve fades in and out will follow either a linear or logarithmic curve. When using the linear
curve, the volume range is from 0% (silent) to 100% (full). When using the logarithmic curve, the volume
range is from -100 dB (effectively silent) to 0 dB (full). For example, a volume level of 50 is 50% linear or -50
dB logarithmic. Extended Fade is a linear fade, but for fades greater than 2 seconds, the fade is done a
second shorter down to 10% of the original volume and then the final fade takes 1.5 seconds. This gives a
more gentle fade out and is the suggested setting.

MIDI input sets the MIDI port for remote control of Cue Player. Available ports are automatically discovered
at program start and then listed. The MIDI Channel number is defaulted to 0, but can be changed by editing
the cueplayerone.ini file entry for MidiChannel. A sub-menu will appear for selection of possible MIDI
devices. Set MIDI Output Port sets the MIDI port for Cue Player One to send output control signals. A sub-
menu will appear for selection of possible MIDI devices.

For Quick cue check the current cue list will be checked one by one to see if the sound files exist where
they need to be.
For Slow Cue Check the current cue list will be checked one by one and 3 seconds of each will be played.

When Action Cue Reminder is selected, changes to a cue that has an action cue associated with it will
trigger a reminder window to check the cue number in that action cue.
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The DMX hardware interface can be chosen. Changing it will dictate a restart of the program. The
devices listed are the most popular brands and are recommended, but other units with a built-in
processor (not "Open" class) should work.

The DMX connection type can be via direct calls to the FTDI interface library D2XX, or by Art-Net.
The FTDI website will have any updates to the driver from the one distributed with CP One.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
http://www.ftdichip.com/Drivers/D2XX.htm
http://www.ftdichip.com/Drivers/D2XX.htm
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The source of the soft patch file, fixture map file, Submasters, Scenes, and Groups can be set to be
either common to CP One or to the current cue file. If you are in a fixed location, "follow CuePlayer"
makes sense, if using a laptop at multiple venues then "follow Cue file" may work better for you. When
you create a new cue file, you may choose existing files to be copied as a start.
Show Inspection tool opens a viewing window and activates a logging function so you can see all the
commands being sent to the DMX interface. It was used mostly during development of the program, but
may prove useful. It is used to select the Art-Net IP address and allows 'under the hood' settings for
LED fixtures. The tool has its own Help page.

Keypad entry of channel levels is enabled by showing the keypad entry window, either by clicking the
menu or pressing the F2 key.

This window can be positioned anywhere and it's last position is remembered. The syntax for entry is:
"channels*level". A range of channels is written "start/end". For example, "2/10-5+12*80" would set
channels 2,3,4,6,7,8,9,10,12 at 80. Pressing the - key on the numpad will give this window focus at any
time it's open.

The Dimmer check goes channel by channel and runs the values up and down so you can check the
lights before a show. You can select automatic advance or manual. Press Esc to exit the check at any
time.

1 to 1 patch mode bypasses the softpatch file and maps channel 1 to dimmer 1, 2 to 2, etc.

Locking out Cue changes sets a flag such that the current cue file cannot be changed. It is remembered
for the file and established whenever the file is reloaded. Unchecking the flag allows changes and will be
remembered as well.
Using the LED curve text file - led.txt - will substitute the file entries for the normal linear dimming
values. The supplied file may give you better dimming on less expensive fixtures. It can be edited with
any text editor.
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The Inspection tool is used to observe the program's DMX output, adjust any problems with LED
fixture settings, and set the Art-Net IP address.

When the tool wiondow is open and a cue is run, the DMX output levels are displayed:

The Read Fixtures button will show a list of the fixture library with the fixture number for each name:

https://www.helpndoc.com/feature-tour/iphone-website-generation
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The numbers identify which fixture may be assigned to a DMX channel.

The addresses and fixture numbers are stored in a set of tables called the 'Fmap'. There are three
sections to the map and they can be viewed by the Read Fmap button:
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and scrolling down:
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Fmap(0) stores the starting address and number of channels for each fixture in use. For example, we
can see that at address 140 there is a 6 channel fixture in place. The number 2000 is a dummy number
for scroller channels.

Fmap(1) has the minimum intensity level for each address. In this case we have a minimum level of 1 for
all conventional instruments. A -1 indicates a color, strobe, or macro channel and won't be changed by
a Blackout command.

Fmap(3) contains the fixture number installed at that address. So for our example, there is an Aurorae
P180 set to address 140.

Should it come about that through installs, removals, rehangs, or whatever these relationships get out of
sync and are not accurate, then the fields and buttons in the lower left can be used to rewrite them. If we
were to put 140 in the DMX addr. field and click Read, then Start would show 140, Dim would show -
1, and Fixture would show 2. Editing any of the fields and clicking Write will change the Fmap
acordingly.

To start from a clean Fmap, meaning you will need to enter the current addresses of all installed fixtures
with the fixture tool, click 'Rebuild Fmap'.

Art-Net

The setup for Art-Net requires that the IP address of the interface(s) be known to CP Lighting. The Poll
button will send out the commands over the network that cause interface devices to respond back with
their name and address. That will populate the drop-down box.
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Clicking Pick 1 will set the displayed address as the one to use for Universe 1. Clicking Pick 2 does the
same for Universe 2. They do not have to be the same device. Back on the Options Menu, clicking
either of the Art-Net options will bring up this screen.
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The keyboard can be used in the following manner:

Esc - clicks the Blackout button, stops a dimmer check

F2 - displays the Keyboard entry window

F3 - toggles the AutoAdvance button

F4 - toggles the Blind/Live button

F5-F12 - the Bump buttons

Pause/Break - clicks the Loop Break button, stops a cue

Home - adds 100 to all active channels

End - subtracts 100 from all active channels. If a cue is running, completes the fade and cue.

Page Up - adds 10 to all active channels

Page Down - subtracts 10 from all active channels

Up Arrow - adds one to all active channels

Down Arrow - subtracts one from all active channels

g# - (where # is 0 thru v) - selects the channels of that group number

g/ - selects all non-fixture channels with greater than warmup value

b or Backspace - runs the previous cue with timer

Space Bar - runs the next cue with timer, completes running loop

Alt - used with a number in a channel - enters values of a user palette

Ctrl - used with b, Backspace, or Space Bar - runs the cue immediately,

            Toggles the Record cue mode between Save and Add

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Delete - clears all selected channels. If a cue is running, stops the fade and completes the cue.

Enter - records the current levels or saves the current timings/description

Shift - used with Enter adds a cue with current levels
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The Help menu has options to redirect you to this file, show you your Registration details, and to bring
up a window with the version and copyright information.

https://www.helpndoc.com/feature-tour
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Keypad entry of channel levels is enabled by showing the keypad entry window, either by clicking the
menu or pressing the F2 key.

This window can be positioned anywhere and it's last position is remembered. The syntax for entry is:
"channels*level". A range of channels is written "start/end". For example, "2/10-5+12*80" would set
channels 2,3,4,6,7,8,9,10,12 at 80. Pressing the - key on the numpad will give this window focus at any
time it's open.

https://www.helpndoc.com/feature-tour
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How or where can I get an interface to use with your software? - The Enttec Pro can be
purchased from Enttec or several distributors on the web. DMX King also makes a compatible
interface that has proven reliable. Both USB and Art-Net interfaces are supported.

I already have an XYZ2000 (or whatever) hardware interface for DMX. Can I use it with your
software? -  If it is not an "Open" class interface and says it is "Enttec compatible" then it should work
with the program. If not and you send me the make, model and the communication source code for the
device, I will make every effort to translate it for Cue Player One. An "Open" class device is one that
does not have an internal microprocessor timer. If you paid less than $40 for it, it's probably an Open.

 How do I run the program as a non-Administrator? - The program needs to be "Run as
Administrator" during the registration process. An easy way to do that is right click the desktop icon and
then select Run as Administrator. Once you have your registration key and have registered the program,
you may run the program normally. 

Can I use an "Open" class interface like the Enttec Open? - No, because the Open interface
uses the host computer for timing the DMX signals that can lead to issues with entry level computers
and a large number of lights. Our experience is that for about the same cost, the DMX King Micro with
its internal timing is a better alternative.

I want to use a surface with sliders instead of having a cue file for everything. - You can
connect a midi sound controller such as the Pyle PMIDIPD30 via a USB port and control the 8
submasters with the sliders.
How do I set up an audio cross fade? - A cross fade used to require 3 cues. The first cue would start
or fade in the first sound and should be set to 'Advance at Start'. The second cue was a 'Fade Out'
action cue to the first sound and also set to 'Advance at Start'. The final cue was the fade in of the
second sound and be set to 'Auto Play'. There is an example cue file on the web site for this. With the
64 bit version, there is an 'Xfade' checkbox and an edit box to enter a cue number to fade out. This only
requires the two cues.

There are other sounds happening as I click and use the program. - It is a good idea to set the
sound scheme to 'No Sounds' from the Control Panel to avoid extra sounds. 

I've got three sounds running all at once. I want to pause them all at once, then start them all
up again later? - This requires several cue lines. Let's say the playing cues are #3, #5, and #6. Action
cues should be added for each of those to Pause them. Set Advance to be at start and select Auto Play
for all but the first. To resume them playing, add another 3 cues with the action to resume in a similar
fashion.

https://www.helpndoc.com/feature-tour/iphone-website-generation
http://www.enttec.com/index.php?main_menu=Products&pn=70304&show=description&name=dmxusbpro
http://www.dmxking.com
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I need a simple sound file editor so I can trim and customize my sounds. Suggestions? -
Audacity is a very good free editor. For simple start/stop settings, that can now be done on the edit
screen.

I'm having trouble getting videos to play or when they do it takes 100% of the CPU. - The
video render mechanism has recently been changed to address this. Please go to the web site to ensure
you have the latest release. If necessary, QMC (Quick Media Converter) is useful to change a video
clip's format should your computer have trouble rendering one format or another.

I want a stereo sound to just go to the Rear speakers, but it still comes out of all of them. -
This is likely caused by your sound card settings. Sound cards will often install a control program that
allows you to simulate 'surround' sound from stereo sources. That must be disabled to get sound only
out of the Cue Player selected speaker set.

What's the best way to save my files between the theatre and home? - The best way seems to
be to have the same directory structure on both computers and to keep all the files, cue and sound, in
one directory per show. Something like c:/shows/thisshow, c:/shows/thatshow, etc. That way you can
copy the whole directory to a thumb drive and be sure you've got everything. You might want to put
your preshow music in a subdirectory (e.g. c:/shows/thisshow/preshow) so you can use the "Create
playlist from Folder" menu option. You could also put your fire marshall/turn off phones speech up in
c:/shows, since it is usually common to all shows. The Backup/Save As menu selection can save the
cuelist and files all together, adjusting the cue list appropriately, as an option.

http://audacity.sourceforge.net/
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Cue Player One is $195.00 and you can purchase a license key from Share-It.

https://www.helpndoc.com/help-authoring-tool
https://order.shareit.com/cart/add?vendorid=41795&PRODUCT[300994537]=1&backlink=https://www.baxeldata.com
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